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When you log in, you are greeted by your
personalized mailbox

View Help Logout Filter: | Al [+] search: | ~|[ crear |

‘ oy HgodCanaI @ lg *) : < ]so&' @v ﬁ Keeping our community connected.

AR Check Mai  Compose Reply Reply Al Forward Delete Mark As More... Calendar

Select: Al Unread None Compact| Disk usage:
Pacific Northwest Concert Update

File

Messages 1to500176 » M
Wed 15:30

Live Nation

« Padific Northwest Concert Update Live Nation Wed 14:49 63KB
« TechNet Flash: Lync Server 2010 Trial, IE9 Platform Preview 7 Microsoft Wed 14:47 57 KB
« Fwd: First Friday, Parade, Fun..News for December Kathryn Kamin Wed 14:25 18 KB
+ Milepost 7 hwy 106 Neil Jones Wed 13:59 1KB
« Live WebcastLaying the Groundwork for Cloud-based App Delivery InformationWeek Wed 13:38 17KB
«+ Still time to save during NCTC’s Hardware Q4 promotion! NCTC Wed 13:34 13KB
+ $20 off Shop our Holiday Hot Buys! Cabelas Wed 13:16 37KB
« 3 Days Only - 10% OFF AOSafety, OCC and EAR Safety Glasses USA Inc. Wed 13:02 21KB -
+ Supercharge Servers: Go Beyond Defragmentation InfoWorld Resources Wed 12:40 10KB
+ Scheduled Report Executive Weekly Summary Report SPC_Server@hcc.net Wed 12:32 196 KB
S + IRS Approved 2010 Tax Forms - Offer expires December 16 QuickBooks Wed 12:18 25KB

Unlock the Value of the Cloud

InfoWorld Resources Wed 11:58
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File View Help Logout

o = Folders to the left help

: _ _
o oo - you find and organize

Sent

‘f: Spam
| Below are various areas
& ] jl; used to configure your
a A ; mail options allowing you
e et ovens to personalize your
SShan, settings.
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New message

Check for new messages

£ Inbox
Drafts

B sen ~ The File menu allows you

= Spam

& Trast - to create or check your

* Inet

_ - mail, as well as to logout

of the system
@ L

E-Mail Settings
ok
Address Email Options
Book
sPaM

Spam
Settings
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Filter: | All |Z| Search:l

E-Mail

l o, Settings\laI
Address Boo

ryans Camame

Inbox
Drafts
Sent
Spam
Trash (13)
Inet

e []]
=3
E-Mail Settings
ok
Address Email Options
Book
spart

Spam
Settings
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Check Mail

.
.
.

4 &g d @ @B B E

Compose Reply Reply All Forward Delete Mark As More... Calendar

Select: All Unread None Disk usage: “

RE: Iron Mountain - question

Dell Chat Session Log

Iron Mountain - question

Recover Mission Critical Applications Fast!

Last Chance: 4G Revenue Management Webinar from Convergys and Light Reading
Dell Chat Session Log

Dell Chat Session Log

Get Headphones & Attend Application Enablement Webinar from Alcatel-Lucent by Light Reading
Free Download: Kensington Physical Laptop Security

Dell Chat Session Log

Dell Chat Session Log

Dell Chat Session Log

Kee

Capps, Adam
Dell Chat
Adam Capps
InfoWorld Resources
Light Reading
Dell Chat

Dell Chat
Light Reading
CRN.com
Dell Chat
Dell Chat
Dell Chat

The View menu allows you to switch
views between E-Mail...
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’ E-Mail
, »s Settings lal

Address
ryans (Crm.

User Interface
Mailbox View
Composing Messages
Displaying Messages

Special Folders

Server Settings

= |
E-Mail Settings

ol
Address Email Options

Book
spam’

Spam
Settings

@ ) @ ] g

Back Preferences Folders ldentities New Identity Calendar

User Interface

Main Options

Language |English (US) El

Time zone |Auto EI
Daylight saving time | |

Pretty dates

Interface skin |hoodcanal ||

List Options

Rows per page

Save

The View menu allows you to
switch to your Settings...
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7 E-Mail — 5 i
o o € 0 G

o2 Settings

Back  New Contact Delete Compose Import Export Calendar
Address Book
I Contacts 1to 6 of 6

Display name
bs@hcc.net

glenn_zack@rbza.com

nancy@hcc.net
ryans@hcc.net

tam

The View menu also allows

. you to switch to the

E-Mail Settings

ol

A%dress Email Options

ook

spant

Spam
Settings
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Help E
Ho About&io =
CcC

LinuxMagic Inc.

Spam (3)
Trash
Inet

E-Mail Settings
%

Address Email Options

Book
spart

Spam
Settings

Tuxedo™ Webmail Help

Welcome to Tuxedo™ Webmail!

Tuxedo™ is an advanced webmail interface for your email server. It has all the functionality you would expect from a modern email client,
including MIME support, address book, folder manipulation, message searching and spell checking. Unlike other webmail clients, its
userinterface has been designed to give you the look and feel of a desktop application. This means that it has features like drag-and-
drop, application menus and minimal page refreshes.

Because of these features, Tuxedo™ requires some advanced browser technologies. At this time we support only the following
browsers (under Windows, Mac OS or Linux systems):

e Internet Explorer 7.0 or higher
e Mozilla Firefox 2.0 or higher

The Help menu allows you to
use the online help.
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f o HoodCanal

"
COMMUNICATIONS

ryans@hcc.net

Inbox
Drafts
Sent

Spam
Trash

Inet

e [l

E-Mail Settings

2 T
Address Email Options

Book
sPar

Spam
Settings

~—

Chech

Select

0 You have successfully terminated the session. Good bye!

sz HoodCanal

COMMUNICATIONS

Welcome to MagicMail Webmail

Username | |

Password | |

® Copyright 2009-2010 LinuxMagic Inc. All Rights Reserved.
www tuxedowebmail .com

Logout ends your E-Malil session.
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- HoodCanal 4 &g ¢ © B B B

" COMMUNICATIONS Check Mail Compose Reply Reply All Forward Delete Mark As More... Calendar
ryans@hcc.net Select: All Unread None Disk usage: 1%

Inbox

+ Packet-Based Transport Webinar from Light Reading Tomorrow
+ HOW TO: Reduce the Risk of Critical Application Data Loss and the Costs of Downtime
7« Free 2 Day Shipping* on Last Minute Gifts
Sent " . GetHeadphones & Attend Mobile Security Services Webinar Tomorrow
Spam (3) 7 . Special offers from Microsoft to tune up your IT skills
Trash "7« JDSU Wavelengths: Submit a MacTrak Story and Win, Industry Leaders on JDSU.tv and more...
Inet "7+ Long Awaited...
7« University Goes Paperless with Tablet PC: Discover How with this Free Download
7« Google TV, iPad, MacBook Air and More!

+ Geta 1-Gig USB Drive | Mobile Video Webinar from Light Reading

Drafts

@ :n 7« 10 Data Integration Proof Points
E-Mail&et’(ings 7« 10 Data Integration Proof Points
Mﬂ ANNEN- Ei n Ranictar Will Raraive =
Address Email Opticns
Book
spant
Spam
Settings

E-Mail link sends you to your inbox.
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File View Help Logout Filter: search: | - |[ clear |

, < HoodCanal ’Z q—d '—a Q @ @" @ Keeping our community connected.

CoMMuNIERTIONS Check Mail __Compose Rep Reply Al Forward Delete Mark As More... Calendar
ryans@hcc.net

Select: All Unread None |Empty||Compact|Disk usage: |_Block Sender_| Messages 1to 50 of 52 > M

* Managing Massive Data Volumes [Twhitepapers.com Resources Mon 08:45 8 KB [N
Inbox .7« Ryan, Your 12/20/10 Issue is Here! Rob Preston, Editor In Chief, Info Mon 08:32 10 KB
Drafts 7+ Follow Up Re: Today's Healthcare IT ChannelCast ChannelCast Mon 07:41 3KB

« Carrier Ethernet Network Service Assurance Whitepaper Light Reading Mon 07:37 2KB
» Still Time for Holiday Shopping - Free Shipping Extended! Griot's Garage Mon 07:18 17 KB
» Still Time for Holiday Shopping - Free Shipping Extended! Griot's Garage Mon 07:18 17 KB
» Last Chance for Holiday Pricing AutoAnything Mon 06:52 41KB
« Top 10 Government Stories Of 2010 InformationWeek Daily Mon 01:04 81KB
. Free Overnight Shipping upgrade on Cards and Books Hewlett-Packard Mon 00:22 17 KB
» Today Only! 25% Off One Iltem & Last Day for FREE Delivery by Christmas Barnes & Noble Sun 23:59 23KB [
+ Today Only! 25% Off One Item & Last Day for FREE Delivery by Christmas Barnes & Noble Sun 23:59 23KB

Sent
Spam
Trash
Inet

W oG o W om D

m

Eail ot + Order by 9PM Monday, 12/20/10 To Receive In Time For Christmas Costco News Sun 21:58 7KB
~hall ettn:
. ,%s » Amazon.com: GetKindle 3G in Time for Christmas Amazon.com sun 11:35 20KB ~
3 r4
A%%r:kss Email Options Subject Managing Massive Data Volumes it =
spart Sender ITwhitepapers.com Resources &
Spam iDi 37
sehimts Recipient ryans@hcc.net &

Date Mon 08:45

| Show Headers |

m

. ® To protect your privacy, remote images are blocked in this message. Displayimages Always show images from online_resources@online.itwhitepapers.com

Meeting High Performance Needs of Massive Data Integration. Learn More Now >> \

Unsubscribe

When working with messages control
them with the buttons in the action bar.
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f - HoodCanal 4 bg ' ¢ O M&:\@

coMmeRTIoNS Check Mail Compose Reply Reply Al Forward Delete ‘endar

~

) ) As read
ryans@hcc.net Select: All Unread None ;[C(}Lpacﬂmsk usage: 0% As unread _
7S i !
m - « Ryan, Your 12/20/10 Issue is Here! As flagged
5 Inbox .7« Your e-mail to internationalbooks As unflagged

Drafts .7« Follow Up Re: Today's Healthcare IT ChannelCast

File View Help Logout

.:.:-:--'HoodCanaI v ) & \-j

COMMUNICATIONS Check Mai cornpose Repw Reply AII Forward Dekte Mark As .‘-
ryans@hcc.net Select: All Unread None |Emph

£ Inbox
B Drafts
& Sent

Print this message
Download (.eml) .

Edit as new

Compact|Disk usage: 0%
+ Ryan, Your 12/20/10 Issue is Here!
« Your e-mail to internationalbooks S e

« Follow Up Re: Today's Healthcare IT ChannelCast Open in new window

» Carrier Ethernet Network Service Assurance Whitepaper

You can use Mark As, and More... for
additional messaging options.
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f :::HoodCanal 4 g ¢ © @B o

COMMUNICATIONS Check Mail Compose, Reply Reply All Forward Delete Mark As More... Calendar

Select: All Unread None | ~ipty Disk usage:

Logout

ryans@hcc.net 1%

File View Help Logout

, <:HoodCanal é’ A%% @ @ Keeping our community connected.

COMMUNICATIONS Back Send SpellCheck  Attach... Save Draft Calendar

ryans@hcc.net Mﬂ @-H
Sender ryans@hcc.net |~ |
mbox Recipient -
B Drafts
S Add Cc | Add Bec | Add Reply-To
Spam Subij
ject I |
¥ Trash Editor type Plain text[ | Check speling [¥]
Inet
& Attachments ‘
_ Attach a file i g
Browse...
E-Mail Settings Maximum allowed file size is 20 MB

o
Address Email Options
Book
spart

Spam
Settings

Close | } Upload

Click Compose to create a new
message, fill in the needed
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¥ o:::HoodCanal

* COMMUNICATIONS

ryans@hcc.net

Inbox
Drafts
Sent
Spam
Trash
Inet

e [l
e
E-Mail Settings
s
Address Email Options
Book

sparf

Spam
Settings

ABG

Spell Check

g @ =

Attach...  Save Draft Calendar

@

Back Send

Keeping our community connected.

Sender ryans@hcc.net | v |

Recipient -
Add Cc | Add Bce | Add Reply-To

Subject [ |

Editor type Plain text u Resume editing

@ Attachments

a\

Test this spellingissu. How does it wrk?

wk
wry
Ark
ark
irk

wok

T L

Close

Click Spell Check in the action bar to
correct any spelling errors. Click on
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.;.'.-.z-‘HoodCanaI a

* COMMUNICATIONS Back Send

Logout

v 9 @ T

SpellCheck Attach... SaveDraft Calendar
ryans@hcc.net

- Sender ryans@hcc.net |~ |
nbox o
Recipient ryans@hcc.net,
= Drafts
Er- Add Cc | Add Bec | Add Reply-To
Spam Subject [New Mail Message
¢ Trash Editor type HTML
Inet
_ N \
\ B I U|EEEE|:Ti=Z=FE 11 « |Ava?_7vFontﬁamily ~ Fontsize v

. | ©Q B H (8T

Test this spelling issue. How does it work?

el []]
e
E-Mail Settings
ok
Address Email Options
Book
spary

Spam
Settings

You can select HTML for fun
personalized messages, when

15
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File View Help Logout |@ Message sent successfully

ryans@hcc.net

Inbox (1)
Drafts
et Sent

s Spam
¥ Trash

E-Mai Settings
[

Address Email Options.

Book pron
spant
Spam
sefings

€« &5 % 4 @ O

Keeping our community connected.

Back Send  SpellCheck Aftach.. SaveDraft Calendar
| Normal | o | EE =
Sender | ryans@hcc.net :I
Recipient ryans@hccnet,

Add Cc | Add Bec | Add Reply-To
Subject Test

Editor type Plain text[~]

& Attachments | + |

Check speling [ v]

The mail program notifies you that
your message was sent.
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File

View Help

Logout

+::*HoodC

ryans@hcc.net

COMMUNICATIONS Check Mail Compose Reply Reply Al Forward Delete Mark As More... Calendar

anal &4 ©&d ¢ © & @

1%

Select: All Unread None Disk usage:

File View Help Logout

«+#HoodCanal

COMMUNICATIONS

[

o

E-Mail Settings

ok

Address Email Options
Book

spant

Spam
Settings

=5 il Keeping our community con
E-Mail Calendar

Today Dec 20 — 26 2010 Day | RIEES
[«I>] ek

Mon 12/20 Tue 12/121 Wed 12/22 Thu 12/23 Fri12/24 Sat 1225 Sun 12/26

all-day

06:00

07:00

08:00

09:00 |

10:00

11:00

12:00

Click Calendar on the main menu to
help keep organized. Click E-Mail to
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,' sHoodCanal @ g O
COMMUNICATIONS Back New Contact  Delete

ryans@hcc.net Contacts 1to 6 of 6

Display name
bs@hcc.net

glenn_zack@rbza.com

nancy@hcc.net

ryans@hcc.net
tam
TigerDirect

=i A
i kI
E-Mail Settings

o
Address Email Options
Book
spart

am
Settings

@ i

Compose Import Export Calendar

The Address Book link sends you to

your address book.
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/ x— Vo \ » 4 i;

wi*HoodCanal @ Lo @ lag 2
COMMBMICATIONS Back  New Contact gDelete Compose Import Export Calendar
Contacts 1to 6 of &

ryans@hcc.net

Display name Add new contact
bs@hcc.net

glenn_zack@rbza.com Display name
nancy@hcc.net First name

I
I
ryans@hcc.net Last name I
I
I

tam E-Mail
TigerDirect Extra Info

" Cancel || Save ‘

e []]
E-Mail Settings
B ="
Address Email Options
Book
spant

Spam
Settings

Click New Contact to add to your address book.
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¢ % Q0 7 &G @ B
s HoodCanal LY , i

commumications Back New Contact Delete  Compose Import Export  Calendar
ryans@hcc.net Contacts 1to 6 of 6

Display name TigerDirect
bs@hcc.net

Display name TigerDirect
Firstname TigerDirect.com
Last name
E-Mail TigerDirect@tigeronline.com
Extra Info

glenn_zack@rbza.com
nancy@hcc.net
ryans@hcc.net

tam

TigerDirect

E-Mail Settings

ol

Address Email Options

Book
spant

Spam
Settings

Just click on your contact to edit the contact

iInformation.
20
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#HoodCanal €@ 18 @ |/ l{u; E O

commumes Back New Contact Delete Compose Export Calendar
ryans@hcc.net Contacts 1to 6 of 6

Display name Edit contact
bs@hcc.net
glenn_zack@rbza.com Display name "I'igerDirect

nancy@hce.net Firstname |TigerDirect.com
ryans@hcc.net Last name I

E-Mail |TigerDirect@tigeronline.com
Extra Info |

TigerDirect

‘ Cancel || Save .

Settings
B )
Address Email Options
Book

spart

Spam
Settings

When finished editing, click Save. You can also
delete the contact using the Delete button.
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File View Help

Logout

HoodCanaI

COMMUNICA

ryans@hcc.net
Display name

E b O
Back  New Contact Delete
Contacts 1to 6 of 6

Compose

Edit contact

4 g

@ o

Export Calendar

bs@hcc.net
glenn_zack@rbza.com
nancy@hcc.net
ryans@hcc.net

TigerDirect

Settings
B S
Address Email Options
Book

spart

Spam
Settings

Display name |[TigerDirect

Firstname |TigerDirect.com

Last name I

E-Mail |TigerDirect@tigeronline.com

Extra Info |

‘ Cancel || Save

If you wish to send a message to the
selected contact you can simply click
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I..HoodCanal @ kg © 7 gy i
v COMMUNICATIONS Back  New Contact Delete Compose Import Export Calendar
Contacts 1to 6 of 6

ryans@hcc.net
Display name
bs@hcc.net

glenn_zack@rbza.com

nancy@hcc.net
ryans@hcc.net
tam

TigerDirect

&1 A
[ LI
E-Mail Settings

ok
Address Email Options

Book
spant

Spam
Settings

You can Import and Export your

address books to and from other
23
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View Logout

File

-~ €« @ 0 7 & @ =
<+ HoodCanal 2 © |- . I

CaMMuNIcaTIionNs Back New Contact Delete Compose Import Export Calendar

Contacts 1to 6 of 6

Help

ryans@hcc.net

File View Help Logout

o HoodCanal HE Keeping our community cor
............... E-Mail Calendar

E-Mail Settings
| [<]»] | Toua Dec 20 — 26 2010 Day Month
Address  Email Options Mon 12/20 Tue 12/21 Wed 12/22 Thu 12/23 Fri12/24 Sat12/25 Sun 12/26
spart
all-day
SS am
ettin
o= 06:00 -
07:00
08:00
09:00 al
10:00
11:00
12:00
13:00

Click Calendar on the action bar to help
keep organized. Click E-Mall to return to the
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“HoodCanal C=: ¢ @ B B @E

o COMMUNICATIONS Check Mail Compose Reply Reply All Forward Delete Mark As More... Calendar
ryans@hcc.net

Select: All Unread None mm Disk usage: 1%

+ Packet-Based Transport Webinar from Light Reading Tomorrow
—— + HOW TO: Reduce the Risk of Critical Application Data Loss and the Costs of Downtime
Drafts + Free 2 Day Shipping* on Last Minute Gifts
Sent "7 .+ GetHeadphones & Attend Mobile Security Services Webinar Tomorrow
Spam (3) 7 . Special offers from Microsoft to tune up your IT skills
Trash « JDSU Wavelengths: Submit a MacTrak Story and Win, Industry Leaders on JDSU.tv and more...
Inet

+ Long Awaited...

« University Goes Paperless with Tablet PC: Discover How with this Free Download
+ Google TV, iPad, MacBook Air and More!
+ Geta 1-Gig USB Drive | Mobile Video Webinar from Light Reading

4 .7« 10 Data Integration Proof Points
E-Mail Settmgs 7« 10 Data Integration Proof Points
Lﬂ ANNEN- Ei n Ranictar Will Raraive =
Address Emall Options
Book
spant
Spam
Settings

The settings link sends you to
the available configuration
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File View Help

Logout

.

ryans@hcc.net

User Interface
Mailbox View
Composing Messages
Displaying Messages
Special Folders

Server Settings

!
E-Mail Settings
ok

Address Email Options
Book

spant

Spam
Settings

sz HoodCanal

COMMUNICATIONS

@ L 15 i

Back Preferences Folders ldentities New Identity Calendar

User Interface

Main Options

Language |English (US) EI

Time zone | Auto [~

Daylight saving time ||
Pretty dates

Interface skin hoodcanal | v |

List Options

Rows per page

The first section changes your
User Interface options.
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s#HoodCanal <@ L 2 [

' COMMUNICATIONS Back  Preferences Folders ldentities New ldentity Calendar

ryans@hcc.net

Section Mailbox View
User Interface Main Options

Mailbox View Show preview pane

Composing Messages Mark previewed messages as read |immediately EI
Displaying Messages Sender notifications |ask the user EI

Special Folders Expand message threads | never E
Server Settings

New Message
Focus browser window on new message

Check for new messages on |every 1 minute(s)El

Check all folders for new messages

)
E-Mail Settings
ok

Address Email Options
Book

spart

Spam
Settings

The second section changes your
Mailbox Viewing options.
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f .. HoodCanal

o° COMMUNICATIONS

ryans@hcc.net
Section

& 5~ S 1o Al

Back Preferences Folders ldentities New Ildentity Calendar

Composing Messages

User Interface
Mailbox View
Composing Messages
Displaying Messages
Special Folders

Server Settings

E-Mail Settings

33

Address Email Options

Book

spant

Spam
Settings

Main Options

Compose HTML messages

Automatically save draft levery 5 minute(s) ||

Attachment names |Full RFC 2231 (Thunderbird) ||

Use MIME encoding for 8-bit characters

When replying Istart new message below original[Z]
Signature Options

Automatically add signature Ialways E
When replying or forwarding place signature | below the quote Z|

When replying remove original signature from message [

The third section changes new
message options.
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f..HoodCanal < =] 2g

* CoMmuNicaTIONS Back Preferences Folders ldentities New Identity Calendar

ryans@hcc.net

Section Displaying Messages

User Interface Main Options

Mailbox View Display HTML

Composing Messages Default Character Set |ISO-8859-1 (Western European) E]

Displaying Messages Display remote inline images |from known senders | v

Special Folders Display attached images below the message never

= O O elfde
Server Settings After message delete/move display the next message |ajways

E-Mail Settings

&

Address Email Options
Book

spart

Spam
Settings

The fourth section changes your
message viewing options.
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f:::HoodCanal = 7] 2 i

COoMMUNIEATIONS Back  Preferences Folders Identities New Identity Calendar

ryans@hcc.net
Section Special Folders
User Interface Main Options

Mailbox View Drafts

Composing Messages Sent en

o
[
[ [

Displaying Messages Spam

Special Folders Trash |Trash

Server Settings

5
(=3

E-Mail Settings

g W"

Address Email Options
Book

spart

Spam
Settings

The fifth section changes where
your messages get stored in the
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f.::HoodCanal

N COMMUNICATIONS
ryans@hcc.net
Section

User Interface

Mailbox View
Composing Messages
Displaying Messages
Special Folders

Server Settings

E-Mail Settings

8 kW

Addrekss Email Options

Boo
spar’

Spam
Settings

@ L

Back Preferences

E~ 15 i

Folders ldentities New Ildentity Calendar

Server Settings
Main Options
Mark the message as read on delete

Flag the message for deletion instead of delete

Do not show deleted messages
If moving messages to Trash fails, delete them

Maintenance
Clear Trash on logout

Compact Inbox on logout

Calendar

Default view Week ||

Time format

H

Timeslots per hour
First weekday n

The last section lets you

change your server settings.
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Keeping our community connected.
E-Mail Calendar

‘HoodGanal
E-Mail Settings

B

Address Email Options
Book o

Spam
Settings

My Email Options

Use this section to add/delete forwarding email addresses, set a vacation message, and change password of your mailbox.

2 Email Addresses Using This Mailbox

Spam Check Virus Check Delivered To

ryans@hcc.net Enabled Enabled This mailbox

ryans@hctc.com Enabled Enabled This mailbox

2 Forwarding

To setup a forward for this email address use the form below. When a forwarding address is set, you can also choose whether to keep a copy of the forwarded messages on this server. We

highly recommend that you do not forward your email as it will reduce the overall spam protection effectiveness. Also, if you are using the spam quarantine, it will not function with a forward in
place.

Forward ryans@hcc.net to | (Add New Forward)

Keep a copy of forwarded messages in this mailbox.

Update Forwards

2 Change Password

This will update your mailbox password and it will affect all of your email addresses.
(min § chars) Update Password

2) Vacation Message/Auto Responder is disabled

The vacation message feature will automatically reply to emails you receive with the custom subject and message body that you enter below. This is useful if you are going to be away from
your email or would like an automatic reply to all emails you receive. You will continue to receive email to your email box as well.

Subject as it will appear on reply email (Default: Auto-Response from ).

I(max 250 characters)

Vacation Message Text:

| will be out of the office from Monday, Sept. 6th, and returning on Tuesday, Sept. 14th. In my absense please contact technical support at 360-898-4357, or the main office at 360-898-2481
for advanced help.

>

m

Thank you,

Ryan Scoles

Enable vacation message: I Update Vacation Message |

>

m

1

Done

€ Internet | Protected Mode: On ¢y v ®100% v

Email Options allows you to change your password sgtc.
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sz HoodCanal

COMMUNICATIONS

E-Mail Calendar

%
Address Email Options

Book )
spart

Spam
Settings

N
EMail  Seftings Anti-Spam Protection

The MagicMail personal spam filter works to filter spam messages regardless of whether you use
Webmail or a client like Outlook Express. By default, the spam filter quarantines spam messages in a
folder called "Spam”. Once activated, this folder is viewable in your webmail, or using IMAP. We
recommend that you routinely check this folder to ensure no legitimate email is getting caught. All
quarantined mail is automatically deleted after 10 days.

@© Normal (RECOMMENDED) (2

@ Normal, (w/Quarantine) @ l AL l

. click here to disable

@ Normal (w/Quarantine) minus blacklists (2)
© Strict @
© Block All, except on WhiteLists 6]

© Customize Rules (NOT RECOMMENDED)

Edit Spam Lists
Subject Blacklist (2
From: Blacklist (2
From: Whitelist (@

(7

Click on the “* to the right of the setting for help.

The Spam Settings let you customize

your spam settings. .
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